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Upgrading MapInfo Professional
Your computer must be connected to the Internet to download the upgrade.

To upgrade MapInfo Professional to version 8.5.1:

1. From the Main menu, select Help > Check For Update. The Maintenance 
Releases for MapInfo Professional web page displays.

2. Create a temporary folder on your hard drive, such as c:\temp\mipro851.

3. On the web page, click the download link to display the File Download dialog 
box.

4. Choose the Save button and save the file to the temporary folder you created 
in step 2.

5. After the download is complete, double-click the executable file to start the 
installation process. Follow the instructions to complete the upgrade. 

Remember that you must use the custom installation process to connect to 
remote databases using the ODBC or Oracle Spatial drivers. However, if you 
decide later that you want to use these drivers, you can return to the 
installation program and perform the custom installation again to install these 
components.

Note: You must agree to the License Agreement to install the maintenance 
release.
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Printing Large and Complex Output Improved
If you have seen the Cannot Print error message when printing, you may be trying to print one or more of the 
following:

• Large format (large page size) maps or layouts containing raster or grid layers that may be translucent or 
transparent

In this case, many times the maps or layouts did not print at all, or if they did print, the translucent or transparent 
layers did not print properly.

• Maps made up of multiple pages that contain borders 

In this case multiple page maps with a border around the entire map would print with borders around each page 
instead.

• Maps that contained labels that span more than one page

In this case, the labels would not print at all or would not print properly.

Largely, these issues were caused by the demand these print requests placed on the system resources in your 
computer.

To resolve these issues we now offer an option that breaks down a print request into smaller blocks, which reduces the 
demand on your system’s resources. Each block is sent individually to the printer driver. This change may allow you to 
print large and complex images that you could not print in the past. We call this feature Subdivide Print. We limit the 
size of each block to 8192 x 8192 pixels.

Caveat
During testing we discovered that many printer drivers handled this new option properly. However we found that the 
output of some printer drivers resulted in gaps that display at the block boundaries. Therefore we did not enable this 
option by default. Since these gaps may affect the quality of your final output, we are giving you the ability to enable 
this option if or when you need it. At this time, we do not have a workaround to remove these gaps. 

Note: If you have both a postscript and a non-postscript version of your printer driver, we recommend you try both to 
see which version gives you better results.

Enabling the New Option
To use this new option, you need to add a registry key to your local machine. We have created an online Knowledge 
Base document that contains the registration (.reg) files inside a ZIP file that you can use to enable or disable this 
option automatically. You will need to save the ZIP file locally, open the ZIP file and double-click the appropriate 
registry file to add this option to the registry. Adding registry keys to your computer requires Administrator rights, or at 
least write access to your computer’s registry. If you do not have this type of access, we recommend you see your 
System Administrator for instructions.

Enabling the Subdivide Print Option Using Registration Files

To enable the Subdivide Print option using registration files in the Knowledge Base document:

1. Go to the MapInfo Knowledge Base entry. Click here to do this now or copy the following address to your browser:

http://testdrive.mapinfo.com/techsupp/miprod.nsf/kbase_by_product/2F7C21FEAFF3145285257243005336AB

Note: If you do not have Internet access, see Enabling the Subdivide Print Option Manually for 
instructions.

2. Open or save the SubdividePrint.ZIP file and, using your ZIP utility, save the two registration files locally. Use 
Windows Explorer to navigate to the registration files. 

Note: We recommend you create a permanent directory in case you need to remove the registration option 
later.
MapInfo Professional 8.5.1 Release Notes 2

http://testdrive.mapinfo.com/techsupp/miprod.nsf/kbase_by_product/2F7C21FEAFF3145285257243005336AB


3. Double-click the SubdividePrint.reg icon to add the new key to the registry.

This option takes effect the next time you open MapInfo Professional.

Disabling the Subdivide Print Option Using Registration Files

If you try this option and you want to remove this functionality, you can disable the registry entry by following these 
instructions.

Note: We assume that you have downloaded the ZIP file that contains the registry files by following the instructions in 
Enabling the Subdivide Print Option Using Registration Files.

To disable the Subdivide Print option using the downloaded registration file:

1. Go to the directory that contains the registration (.reg) files you downloaded earlier.

2. To remove the Subdivide Print option, double-click the UndoSubdividePrint.reg icon. The registry entry is 
updated with the new value.

This option takes effect the next time you open MapInfo Professional.

Enabling the Subdivide Print Option Manually

If you do not have access to the Internet, or you want to add this option manually, follow these instructions.

To enable the Subdivide Print option by entering the registration key manually:

1. From the Start menu, click Run and type the command regedit. Click OK to display the Registry Editor window.

2. In the HKEY_LOCAL_MACHINE entry, navigate to Software > MapInfo > MapInfo > Common.

3. From the Edit menu, select New > DWORD Value. A new entry displays in the list.

4. Right-click the entry and select Rename. Rename the new entry SubdividePrint and press Enter.

5. Double-click the new entry to display the Edit DWORD Value dialog box.

6. To enable the Subdivide Print option, type 1 in the Value data field and click OK. 

To disable this option, return to this dialog box, type 0 in the Value data field and click OK.

This option takes effect the next time you open MapInfo Professional.

Note: You can also remove this regedit entry entirely to remove this option.

SQL Server 2005 Support Added
We have updated MapInfo Professional to support changes in the MS SQL Server 2005 schema concept. Microsoft 
has enhanced SQL Server 2005 to use schemas to organize database objects into namespaces. In the past the 
schema was part of the owner/user construct, so when you deleted a user, you deleted the objects associated with that 
user. 

Using SQL Server 2005, objects are associated with a schema, which can be associated with many users and each 
user can be associated with many schemas. 
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The old fully qualified name of a database object was:

Server.Database.User.Object.

The new fully qualified name of the object is:

Server.Database.Schema.Object 

If you leave out the server and database name identifiers, MapInfo Professional uses the current server and database 
names. If you do not explicitly specify a schema for a user, the server assumes any unqualified object names are in the 
default schema. Therefore, if you are accessing a SQL Server 2005 database, you need to update any features/
functions, tools, and test scripts accessing the objects, including the metadata in the MAPCATALOG, to use the new 
fully or partially qualified object name. 

To make this version of SQL Server work, you must have this 8.5.1 version of MapInfo Professional. There is a work 
around for MapInfo Professional 8.5 and earlier versions that accesses a server table with the form, 
Database.Owner.Object. Review the MapInfo Professional 8.5 User Guide documentation for these instructions.

SpatialWare 4.9 Support Added
MapInfo Professional now supports SpatialWare 4.9 which has been upgraded to support SQL Server 2005. 

Accessing Tables Under Different Schemas
When you access a SQL Server 2005 database and you display the Open DBMS Table dialog box, you notice that the 
Owner label has changed to Schema, to reflect the new naming convention.

The default entry is the default schema of the currently logged in user. The drop-down list still displays all of the other 
available schemas. After you access the database, every operation should work as it did before. There is the same 
editing limitations as before. 

Note: You cannot edit a table that you do not have rights or permissions to edit and the schema does not display in 
the list if there is no table associated with it.

Review 
available 
schemas and 
the tables under 
them by 
selecting them 
from the 
drop-down list.
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Saving and Creating New Tables
We have made two changes to the Create New Table and Save Table As operations that you may notice in this 
release. 

Neither the Create New Table nor the Save Table As operations allow you to choose an owner, but you can always 
create/save table under the default login/owner. As a result, we have changed the word Owner to the word Schema in 
the Save Copy As and Create New Table dialog boxes and the default login schema is selected by default when you 
select a SQL Server 2005 database.

The second change is that you can choose among the available schemas for SQL Server 2005 in the Create New 
Table or Save Table As dialog boxes. Remember, to select a schema doesn't mean that you have the permission to 
create a table under that schema on the server. You need to know which schemas you can create and save tables 
under and which you cannot. If you are not sure whether you have these permissions, check with your database 
administrator. An operation will fail if you do not have the required permission(s) on the chosen/given schema.

Uploading a Table into a Specific Schema
If you do not specify the schema name when you upload a table, EasyLoader will upload the table using the user's 
default schema when uploading to a SQL Server 2005 server. This includes the registration into MapCatalog. The 
schema name is inserted into column OWNERNAME of MapCatalog. 

Note: Ask your Database Administrator for information if you don't know your default schema to ensure that you know 
where the tables you are uploading are being stored. 

You must have the proper permissions on the default schema to upload the table successfully. If you know which 
schema you want to upload the table to, you can specify the schema using the user interface in EasyLoader or using 
the command line options. See the EasyLoader documentation for the command line instructions.

To upload a table to a specific schema:

1. From the Tools Menu, select the EasyLoader option and the EasyLoader submenu. The MapInfo EasyLoader 
dialog box displays.

2. Select the appropriate database connection and source table you want to upload.

3. Select the appropriate server table names and processing instructions.

4. Click the Options button to display the additional fields in the Options dialog box.

Use the Schema drop-down list to select a schema to which you want to upload your data. The default 
schema displays in the drop-down list.

5. Select the other upload options as appropriate and click OK. The EasyLoader dialog box redisplays.

Select a schema to 
that you have 
rights to or the 
upload will fail.
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6. Enter the TAB file directory for the server tables in the field provided and click Upload to begin the upload process.

SQL Server 2005 allows one user to associate with many schemas, so MapInfo Professional provides the ability to 
choose among the available schemas to which to upload your data. It is up to you to know which schemas you have 
rights to create tables under. If you do not have the appropriate permissions to a selected schema, the upload process 
will fail. Ask your database administrator for more specific and detailed information about your uploading rights.

Progress and Resolution of Outstanding Issues 
The following outstanding issues have been corrected in this maintenance release:

Oracle OCI Connection Workaround
In general you cannot connect to an Oracle database when there are parentheses in the application’s path. This has 
been a long standing limitation in working with Oracle databases.

You may notice this connection difficulty if you are running MapInfo Professional on a 64-bit Windows operating 
system. The MapInfo Professional OCI driver is not able to connect to your remote data because Microsoft adds (x86) 
to the end of the Program Files directory to run 32-bit applications. This addition of the parentheses prevents the 
application from accessing Oracle data. 

To resolve this issue, we recommend you install MapInfo Professional in a discrete directory, such as c:\MapInfo. 
Trying to install MapInfo Professional explicitly into the Program Files directory does not appear to work, because 
Windows seems to redirect the application into the \Program Files(x86) directory anyway. Oracle appears to be aware 
of this issue, and we will continue to monitor any changes that affect this issue.

Administrative\Preference Issues
The following administrative and preference issues have been resolved:

Issue # Description/Resolution

S10003 There is an undocumented change in behavior using <Ctrl A> shortcut between v8.0 and v8.5. Previously when 
you selected an object and then used the <Ctrl A> shortcut in the Map and Browser windows, you would scroll 
to the associated browser record.

Resolution: In v8.5 the application scrolls to the associated browser entry AND zooms to the object in the Map 
window. We have removed this functionality.

T17821 In the Options > Preferences > System Settings dialog box, after setting the Default Paper and Layout Units, the 
system uses incorrect paper units, other units are correct. 

Resolution: This occurred because the application would set the paper units and the session settings in the 
wrong order. To correct this issue we set the paper units after other preferences are changed. This 
means the default paper units you set, remain in place.

T20275 When the Application expects to display a MapInfow.wor file at startup, but cannot find that file, an error 
message displays that is not very informative. 

Resolution: We have corrected this to provide a more meaningful error message.
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Coordinate System Issues
The following coordinate system issues have been resolved:

Geocoding Issues
The following Geocoding issues have been resolved:

Issue # Description/Resolution

T20081 The Custom PRJ entry is using affine transformation results incorrectly when saving cosmetic objects. 

Resolution: We have changed the way we convert custom coordinate system datums. In the past, we wrote 
custom datums out in 8 parameters even if the last five parameters were 0. Now we attempt to write it as a 
three parameter datum when the last 5 parameters are zeros. This makes coordinate system string 
shorter and does not fail our internal string limit.

Note: This issue could still occur for coordinate systems with 8-parameter datums, affine transform and 
bounds.

T20286 Raster in French Lambert RGF93 not reprojecting correctly if using Always method and the image is pixelated if 
using Cubic Convolution.

Resolution: There was an error in the calculation of the nearest neighbor algorithm for the Always method that 
caused this issue. The algorithm did not begin the calculation with the nearest neighbor pixel, but rather a pixel 
two pixels away. This has been corrected so images should display correctly.

Issue # Description/Resolution

T19603 When some users ran Select and Georesult statements after geocoding, the results would be different. 

Resolution: The application was reporting a result as a close match when there was no match at all. So when 
you queried the number of matches and non-matches, the results were different from those reported by the 
Geocode command.

We have corrected the code to perform a second check on the actual address returned and correctly process it 
as not a close match.

This issue only occurred when you were using a MapMarker server and only when geocoding using CASS 
evaluation mode. The issue is related to further CASS certification that is performed by the MapMarker U.S. 
product but not by MapInfo Professional. CASS is an evaluation process for address matching software 
established by the U.S. Postal Service and the mailing industry. MapMarker U.S. conforms to this standard for 
U.S.-only geocoding.

Note: This issue did not occur when you used the Envinsa server to geocode your data.

T19687 Entering an incorrect local geocoder field creates points but does not update any columns.

Resolution: When you enter an incorrect local geocoder field, the application now displays an error message 
warning you that it cannot complete the geocoding process. To resolve this issue, check the field information 
and correct it in the geocoding request.

T19729 Inconsistent/Incorrect results display when using Interactive Geocoding on an Envinsa server.

Resolution: For Envinsa servers, in Automatic geocoding mode, we no longer allow the entry in the Max 
Candidates field to be less than 2. This ensures that the results are consistent between Automatic geocoding 
and Interactive Geocoding.
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Google Earth Link Tool Issues
The following Google Earth Link Tool issues have been resolved:

Issue # Description/Resolution

T20105 The application closes suddenly if you try to geocode to an invalid Envinsa server.

Resolution: When you try to geocode a table using an invalid Envinsa server, an error message displays 
informing you cannot connect to the server. Please check the URL of the server you are attempting to connect 
to and try again.

Issue # Description/Resolution

B10069 Specifying output paths with spaces cause errors.

Resolution: This appears to be a Google Earth limitation in the beta software. We are monitoring new releases 
of Google Earth to see if Google corrects this issue. In the interim, we recommend that you create output paths 
with no spaces in them to avoid this error.

T18449 Double-Byte character sets need to be handled differently than Single-Byte character sets. 

Resolution: We have updated our utility to accommodate Japanese, Simplified Chinese, Traditional Chinese, 
and Korean character sets.

T19941 The Height field set to a column does not work on multipolygons that contain holes or islands. 

Resolution: To resolve this issue we make sure that you have made a selection when trying to get a height from 
a column.

T19955 The Height field does not persist when exporting map data to Google Earth. 

Resolution: We have modified the utility to ensure that the Height field does persist when you export a map. 

T19976 Polygons with holes don't get filled correctly if they have an altitude.

Resolution: This issue was related to the order in which the points of the polygon were written. To correct this 
problem, we ensure that the points are written in counter-clockwise order in the KML file.

T19989 Extruded objects are not filled in completely. 

Resolution: This issue is related to issue T19976 above because extruding is also dependent upon the order in 
which the points are saved in the KML file. Google Earth expects the points in a polygon to be listed in a counter-
clockwise direction; MapInfo Professional doesn't care whether the points are saved clockwise or counter-
clockwise. We have modified the utility to ensure that the points are written in the correct order in the KML.

T19995, 
T20106

Objects in Seamless layer do not have the choice of KML or Raster. 

Resolution: This issue occurred when the selected objects of a Seamless layer were not in the frontmost 
window. This prevented you from choosing between the KML and raster formats. We have updated the code to 
allow selections that are in any window. To see this chance, open two Map windows and make a selection in one. 
Select the other to ensure that it is topmost. Click Map > Google Earth Link > Export to Google Earth and the 
application offers to export the selected object, even though it is not in the topmost window.

T20067 Bad value for <extrude> tag. 

Resolution: This change will be visible only to someone who inspects the exported KML file. We corrected the 
utility to write 1 instead of the height value in the <extrude> element. This resolves the issue.
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Layout Issues
The following Layout issues have been resolved:

Issue # Description/Resolution

T20088 The application closes suddenly when you try to send maps to Google Earth if the path to Google Earth is invalid 
in the registry. The Google Earth path might get corrupted if you reinstall it. 

Resolution: We have updated the utility to use the Windows File Association facility instead of the registry to 
store the path. This prevents the sudden closure of the application. 

T20433 If you attempt to export to Google Earth when there is no open map, an error results.

Resolution: We have corrected this problem handling the condition when no Map window is open and we have 
made the error message more meaningful.

T20737 When you try to change the file name of the copyrighted text file in the application, the new file name is not 
recognized.

Resolution: We have corrected this issue so that the new file name is saved properly.

T21034 You can access the Export Map Image to Google Earth dialog box and the Send to Google Earth now check 
box is enabled even when Google Earth is not installed.

Resolution: We have resolved this issue by checking to see if Google Earth is installed before allowing access 
to this functionality. This issue is related to T20088.

Issue # Description/Resolution

B10072 In the Layout Window, a frame that contained a Ranged Theme Legend displayed white spaces if there were 
gaps in the range values. 

Resolution: Thematic legends now correctly size and display their contents whether they are embedded in the 
Map, Layout or Legend windows. See T20565.

B10073 In the Layout Window, the legend title was truncated when the Theme Legend of Map window was used in a 
frame for the legend. 

Resolution: Thematic legends now correctly size and display their contents whether they are embedded in the 
Map, Layout, or Legend windows. See T20565.

T18576 A Layout created by one frame for a window did not represent the size of pie chart thematic accurately.

Resolution: The scale for pie and bar legends now depends upon the scale of the map when the map is 
embedded in a Layout window. This resolved the issue.

T20618 The contents of the Message window do not appear in Layout windows.

Resolution: We changed a data type that prevented the contents of the Message window from displaying, which 
corrects this error. Now, if you copy a Message window to a Layout, the contents of the Message window display 
properly.
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Map/Thematic Map Issues
The following map and thematic issues have been resolved:

Issue # Description/Resolution

21729 Modifying a new Grid thematic layer from Layer Control resulted in inappropriate errors.

Resolution: The Grid thematic layer is now set when the Layer Control dialog box is closed to prevent these 
errors and to create the thematic layer properly. This corrects the issue.

B10048 The error message, All or part of Object(s) invalid displays when you buffered small polyline 
objects. 

Resolution: We have corrected the out of memory issue that caused this error.

B10070 Border styles for regions were not saved when you created a thematic map using the Individual Value Qualitative 
Light & Dark or Qualitative Pastel thematic templates. 

Resolution: This issue occurred when you changed the border but not the fill style of a thematic map. We have 
corrected this to save the border styles for regions when you save the thematic template.

T12330 The IDW Interpolator accepts non-numeric characters as input and treats them as zeros.

Resolution: We added stricter validation for the Search Radius and Grid Border fields to ensure that you cannot 
enter non-numeric characters. For example, entries such as abc, and g0 will cause an error, but 3g will be 
interpreted as 3. We made similar changes to TIN Interpolator Settings dialog box.

T15989 A Workspace file with thematic modifiers using zoom constraints and converted to MWS may not display the 
same when viewed in MapXtreme 2005.

Resolution: MapInfo Professional and MapXtreme 2005 use slightly different visibility rules for modifiers 
because of their different object models. In MapInfo Professional a thematic modifier is a separate layer and may 
be visible even when its data layer is not. In MapXtreme, if a data layer is not visible, then none of its thematic 
modifiers are visible. 

Therefore, to get the closest visual and behavioral match between the two products, we have made the MWS 
visibility rules for the data layer to be at least at the same level as the visibility rules of the union of all its 
modifiers.

For example, if a data layer is not visible in MapInfo Professional, but has two modifiers, one with a zoom range 
of [20 mi, 30 mi], and another with a zoom range of [30 mi, 40 mi], then the data layer is written to the MWS with 
a zoom range of [20 mi, 40 mi], using the lower and upper values of each range.

If one of the modifiers has a zoom range of [2 mi, 10 mi] and the other modifier has a zoom range of [20 mi, 100 
mi], the resulting zoom range for the data layer in the MWS is [2 mi, 100 mi]. This means that when viewing at a 
zoom level between 10 mi and 20 mi, the data layer will be visible in MapXtreme, but not in MapInfo 
Professional.

T17352 Some points were ignored when creating a Voronoi polygon. 

Resolution: Previously, floats and rounding errors were causing Voronoi points to combine into one. This has 
been corrected.

T18074 The Object > Split function is producing a invalid objects error. 

Resolution: To correct this error, we changed the way objects are processed so the invalid objects are not 
created.

T18182 Images no longer line up after reprojection. 

Resolution: We have changed the algorithm that caused this error to prevent this issue from occurring.
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Issue # Description/Resolution

T18464 Custom symbols do not reload properly when using Reload Custom Symbols statement.

Resolution: We added a method that properly qualifies the full path to the custom symbol, which resolved the 
issue. 

T19138 The Legend frame size was incorrect for a theme with the swatch size set to font size. 

Resolution: Thematic legends now correctly size and display their contents whether they are embedded in the 
Map, Layout or Legend windows. See T20565.

T19570 Problem opening workspaces that use an expression with wild cards in an Individual Thematic Map. 

Resolution: We have corrected this issue by improving the writing of a shade statement. You can use wild cards 
(*) in expressions when opening workspaces.

T19901 Extra lines are visible when drawing a region with many holes. 

Resolution: We converted the memory size of points to accommodate larger points. When we did that, it 
became possible to add more points than were usually allowed. This caused the extra lines when drawing 
regions with holes in them. We have changed this code to prevent these extra lines from drawing. We could 
make this change because we no longer are limited by the Windows 98 operating system.

T19920 Label Zoom Layering values are not converting correctly when changing Map Distance Units from kilometers to 
miles. 

Resolution: There was an issue with the conversion formula that has been corrected.

T19996 The Automatically Open Default Theme Map Window Preference and Display Vertical Mapper Grid as 
System Preference were being ignored when you dragged and dropped or double-clicked a table from outside 
the application, or added a table as a layer using Layer Control.

Resolution: Here are the changes we made to correct these issues. Once you select the Automatically Open 
Default Theme preference: 

• When you add a table with a default theme in the metadata as a layer using Layer Control, MapInfo 
Professional adds the table's default theme to the Map

• When you add a table with a default theme in the metadata by double-clicking the Map from outside the 
application, MapInfo Professional adds the table's default theme to the Map

When you select the Display Vertical Mapper Grid as preference:

• MapInfo Professional honors the preference when you drag and drop a table you created with Vertical 
Mapper.

T20121 Problems editing the Pen Style (border) for Qualitative Thematic Templates. 

Resolution: This issue arose when you created or modified themes based on the new Qualitative Theme 
Templates (introduced in v8.0). Due to this change the pen style of the borders are no longer ignored. We have 
corrected the problems this caused to save the border styles for regions when you save the thematic template. 

T20233 Cutting and pasting objects causes changes in zoom during paste operation. 

Resolution: We have changed this behavior to prevent the zoom during the paste operation.

T20280 If you created a Hotlink in a workspace, it would not save to the workspace if the layer was not visible.

Resolution: We have updated the code to allow you to save a Hotlink regardless of the visibility of a layer.

T20450 There is a selection display issue in Query windows when you select an object in the Map window. 

Resolution: In the past when you made a selection in a Map window, the application needed to highlight the 
selection not just in the Selection window, but also in any other open windows in which the object occurred, 
including Query windows. This has been corrected.
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Miscellaneous Issues
The following miscellaneous issues have been resolved:

Issue # Description/Resolution

T20565, 
B10072, 
B10073 and 
T13085

When double-clicking some areas of a thematic legend, the wrong legend displays for editing.

Resolution: The code that determines the size of a thematic legend is separate from the code that draws the 
legend itself. In time, these different sections of code got out of sync, which caused the problems in this list of 
bugs. These issues have been resolved as part of this maintenance effort. The legend you double-click to edit is 
now the legend that displays for editing.

T21074 When you created a thematic grid file from a Float field in an expression, the application wrote a decimal width of 
0 to the .TAB file’s metadata. This caused the decimal values to be discarded. When you reopened the table you 
could see this in the InfoTips or using the InfoTool.

Resolution: We have updated the application to write the appropriate decimal width for float values into the 
table's metadata when you create a thematic grid. 

T21132 The Line object was showing twice in the Legend window after all of the line styles were converted to the same 
pattern.

Resolution: The pen patterns used to draw both lines had the same visual appearance, however, one was to be 
drawn as interleaved and referenced a different pattern value. To correct this issue, we added a new method that 
compares line styles and border line styles in cartographic legends for visual equality.

Issue # Description/Resolution

T19528 When you click the Add button to add a Request Value in the Create Driving Regions dialog box, the new entry 
is usually the same style as the previous entry, but not always.

Resolution: We have corrected this issue so that the style of a Request Value is the blue cross hatch pattern 
every time, no matter how many time you add a new value.

T20872 When loading query templates into the Select or SQL Select dialog box, spaces between a column name and 
the keyword "Desc" or "Asc" in an "Order By" clause were being removed. As a result, the Application 
misinterpreted the query. The problem also arose when you opened queries saved using the File > Save Query 
menu option.

Resolution: We have corrected this so that queries are now being interpreted properly.

T21135 The application displayed the error,” Total record length must be no longer than 4000 bytes” when you 
added a column to a table with only 3782 bytes in length.

Resolution: There was an issue with the way the data types in the table were calculated. This calculation 
method has been corrected but there is still a 4000 byte total record limit.
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MWS File Issues
The following MWS file issues have been resolved:

Issue # Description/Resolution

T12184 Labels of invisible layers display in MWS files. 

Resolution: We have implemented new rules for writing label layer and label source visibility/zoom range when 
creating MWS files. 

1. If the data layer has a visibility zoom range but no label zoom range, the MWS label source zoom range 
should be the data layer zoom range;

2. If the data layer has a label zoom range but no visibility zoom range, the MWS label source zoom range 
should be the label zoom range;

3. If the data layer has both a visibility and a label zoom range, the MWS label source zoom range should be 
the intersection of the two zoom ranges.

The data layer's zoom range in the MWS file may be altered based on its thematic modifier zoom ranges in 
MapInfo Professional, but in this case when we need to inherit the data layer's zoom constraints, we use the 
original constraints so that labels appear in MapXtreme 2005 as they do in MapInfo Professional. See the 
resolution for T15989 for more information.

T16681 Can't open MapInfo Professional MWS files in Workspace Manager. 

Resolution: This problem was related to Row IDs and has been resolved by not translating Row ID queries into 
MWS files. You can open MWS files in Workspace Manager now.

T17079 The “None” symbol in the MapInfo 3.0 Compatible Vector Symbols does not translate correctly to MWS files. 

Resolution: When you create an override for a point layer and select an invisible point style, the application 
uses the vector version of MapInfo 3.0 Compatible symbol styles.

Note: If you select the preference for displaying pre-version 4 symbols using a TrueType font, this does not 
occur.

However, the internal code for a MapInfo 3.0 Compatible invisible symbol, or "None" cannot be written to an 
MWS file because it is not a printable character. We recommend you use the "None" symbol from a TrueType 
font instead to resolve this issue. We have implemented this workaround in the application so you do not have 
to.

T19357 Cannot save a layer’s selectability state in an .MWS file. 

Resolution: We added layer selection and edit states to MWS persistence to enable this functionality. The 
editable layer is also persisted as an insertable layer in the .MWS file. 

T19719 The application closes suddenly when you try to save a workspace containing a Quantile Range thematic map 
as a.MWS. 

Resolution: MapInfo Professional was using the wrong method to test for a valid quantile expression. This has 
been corrected.

T20211 MWS ImageWidth and ImageHeight output is incorrect. 

Resolution: For this issue, we corrected the way the map’s pixel size was calculated. MWS image sizes are 
correct now.

T20853 A workspace with a Quantile Thematic layer saved to a MWS format, forces the application to close suddenly.

Resolution: MapInfo Professional was using the wrong method to test for a valid Quantile expression. This has 
been corrected.
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Printing Issues
The following printing issues have been resolved for Maps and Layout files:

Raster Issues
The following raster issues have been resolved:

RDBMS Issues
The following remote database issues have been resolved:

Issue # Description/Resolution

28268 Printing transparent/translucent layer combinations often resulted in losing some or all of the data during 
printing.

Resolution: We have corrected this issue by changing the way MapInfo Professional prints maps. The 
application now breaks map images into small blocks which can handle the transparent and translucent layer 
combinations better. 

T20256 The application throws a page margin error when you resize a map that requires large scale printing.

Resolution: We updated the program to handle larger page dimensions. This correction works for both Map and 
Layout files.

Issue # Description/Resolution

T17039 The Save Window As command creates a raster image one pixel too wide and one pixel too tall for Map and 
Layout windows. 

Resolution: We have corrected the calculations required to save a raster image window to prevent this issue 
from occurring.

T19653 After raster reprojection, a ghost image displays behind the reprojected image.

Resolution: We have corrected this issue by selecting the appropriate transparent color during the raster 
reprojection process.

T21347 Panning raster images is noticeably slower in MapInfo Professional 8.5 than earlier versions.

Resolution: We have corrected this issue to improve the performance of panning in raster images.

Issue # Description/Resolution

T20364 Tables uploaded to Oracle with newer projections are inserting a null into SRID metadata table when Oracle 
supports that projection.

Resolution: This issue was resolved for the following projections only: Danish System 34 Jylland-Fyn, Danish 
System 45 Bornholm, and Danish System 34 Sjaelland. A larger project may be undertaken to correct this issue 
for other projections.

T20421 You could not open a LIVE access Oracle table if you were not the owner.

Resolution: We have changed the application to allow you to open any Oracle table that you have rights to, 
regardless of the ownership of the table.
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Tool Issues
The following tool issues have been resolved:

WFS/WMS Issues
The following Web Services issues have been resolved:

Issue # Description/Resolution

T21057 The Preferred View drop-down entry did not persist after you changed the DBMS symbology and made the table 
mappable. 

Resolution: We have expanded the original work done to persist the previously set Preferred View to include 
the Change DBMS Style and the Make Table Mappable conditions. 

T21068 When you clicked the Back button in the Open DBMS Table Options dialog box, the default owner would display 
in the Owner field rather than the owner you selected.

Resolution: We have corrected this issue to ensure that the owner you select going into the Open DBMS Table 
Options dialog box is the same when you return.

Issue # Description/Resolution

T20460 The Labeler and Workspace Resolver tools start up with blank Message windows. 

Resolution: These issues were caused by changes that allow users to copy the contents of the Message 
window. We have updated the code to prevent this from occurring.

T21080 Universal Translator: A MSVC runtime error occurs you translate files from .DWG to .TAB formats. 

Resolution: Safe Software, who provides the Universal Translator to the application has corrected this issue in 
their software. To see this change, open a .DWG file and convert it to a .TAB file. 

T20580 When using the Universal Translator (a third-party product of Safe Software) to translate a file to .TAB or .MIF 
format, the result no longer displays as expected. 

Resolution: In the past when using the Universal Translator (UT) to translate a file to .TAB or .MIF format, if you 
did not specify a projection, the application used a Non-Earth Coordinate System. Safe Software’s UT build for 
the 8.5 version set a default (0,0)(10,10) bounds for Non-Earth Coordinate Systems, when it should have used 
the bounds of the data instead.

We made a change in UT to work around this issue for the 8.5.1 patch. When you are translating a file to .TAB or 
.MIF format and do not specify a coordinate system, we use the bounds of the data, which corrects this issue.

Issue # Description/Resolution

T18401 When downloading WFS layers in GML2 image format, an error results due to incorrect parsing of WFS 
GetCapabilities on the server. 

Resolution: We have corrected the way WFS GetCapabilities are parsed for WFS layers. You can now 
download WFS layers with GML2 images more successfully.

T19166 If the Map window contains a seamless layer and a WMS layer and you try and access the Layer Control dialog 
box, the application closes suddenly. 

Resolution: We have corrected this issue to prevent this sudden closure from occurring.
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Issue # Description/Resolution

T19547 When an Envinsa WFS server issues a service exception, the application creates an empty table. 

Resolution: MapInfo Professional's WFS client did not recognize service exceptions issued by the Envinsa WFS 
service because no content type was specified. The client was therefore treating the returned information as 
empty data rather than an exception. This has been corrected.

T19715 No error message displayed when the server timed out. 

Resolution: We have added an error message to indicate that the server has timed out when you attempt to test 
a connection using the Test URL button.

T20181 There was an issue when you tried to access Non-Earth Tables using a bounded coordinate system string. If you 
tried to save a WMS layer in an unsupported projection as a .TAB file and tried to add a Non-Earth entry to the 
PRJ file with bounds, errors would result. 

Resolution: We have changed the application to write the Non-Earth coordinate system clause with bounds and 
modified the system to retrieve these bounds from the WMS server when possible. This allows you to retrieve 
WMS layers in Non-Earth format and still use them in your maps.

T20354 An error occurred when you opened a WFS Table using a Row Filter. 

Resolution: We corrected a coordinate system initialization issue that prevented the application from being able 
to open the WFS layer. This should prevent this issue from occurring again.

T20830 Unable to get SSL3 secure https channel using client certificates to access WMS server.

Resolution: MapInfo Professional's WMS and WFS clients now support Secure Socket Layer (SSL)-protected 
sites that require users to select a client certificate or require user confirmation to bypass server certificate issues 
such as invalid certificate authority, invalid certificate common name (CN), or expired certificates.

T20973 WFS Server causes the application to lose focus when processing DescribeFeatureType.

Resolution: We have changed the way we processed the XML that underlies the DescribeFeatureType to 
resolve this issue. You can now open WFS layers that contain this feature without error.
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